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1.Εισαγωγή

Τα τελευταία χρόνια η εξάπλωση του διαδικτύου είναι ραγδαία και ο αριθμός των  νέων 
ιστοσελίδων αυξάνεται καθημερινά, έτσι  όμως έχει αυξηθεί και ο ανταγωνισμός και οι απαιτήσεις 
των εταιρειών, χρηστών  για ιστοσελίδες ποιο σύνθετες και πιο απαιτητικές.  Παράλληλα η ανάγκη 
διαφήμιση μεσώ διαδικτύου αυξάνεται, με συνεπεία να αυξηθεί η ανάγκη για αξιόπιστη γρήγορη 
και πάνω από όλα εύκολη κατασκευή ιστοσελίδων.  H παρούσα πτυχιακή εργασία έχει ως θέμα την
δημιουργία μιας διαδραστικής ιστοσελίδας με την χρήση ενός συστήματος διαχείρισης 
περιεχομένου (CMS – Content Managment System) για την διδασκαλία του λογισμικού Photoshop. 
Αρχικά γίνεται επεξήγηση των συστημάτων και της δομής αυτών, αλλά και ανάλυση της ιστορική 
αναδρομή τους.  Έπειτα ακολουθεί ανάλυση των πιο δημοφιλή συστημάτων διαχείρισης 
περιεχομένου όπως είναι  το  Wordpress, Joomla Drupal, SquareSpace  και στην συνέχεια η επιλογή
του καταλληλότερου σύμφωνα με τις ανάγκες  για την ιστοσελίδα, στην περίπτωση αυτή το 
καταλληλότερο CMS είναι το WordPress.  Για την εγκατάσταση του WordPress απαιτείται η χρήση 
ενός http server, μιας βάσης δεδομένων και μιας γλώσσας scripting ( PHP).  Για την εγκατάσταση 
αυτών θα γίνει  χρήση του προγράμματος Wamp το οποίο πραγματοποιεί ομαδική εγκατάσταση 
των απαιτούμενων προγραμμάτων.  Στην συνέχεια δημιουργείται μια βάση δεδομένων και η 
εγκατάσταση του λογισμικού Wordpress.  Αφού πραγματοποιήθηκαν όλα τα παραπάνω ακολουθεί 
επιλογή του θέματος (Theme) με βάση τις ανάγκες της ιστοσελίδας και η σχεδίαση του τρόπου 
δόμησης της, σε σελίδες (Home,  About, Contact, Tutorials, Portofolio) , κατηγορίες (tutorial)  και 
άρθρα (ανάρτηση των video για την εκμάθηση του Photoshop) .  Έπειτα ακολουθεί η υλοποίηση 
των σελίδων, των κατηγοριών και των άρθρων σύμφωνα με την δομή της ιστοσελίδας , αλλά και η 
εγκατάσταση των προσθέτων όπου θα χρησιμοποιηθούν ( Plugins).  Με την ολοκλήρωση του menu
πλοήγησης ολοκληρώνεται η ιστοσελίδα.  Στην συνέχεια υλοποιούνται τα εκπαιδευτικά video για 
την εκμάθηση του λογισμικού Photoshop με την χρήση προγράμματος καταγραφής οθόνης και 
προγράμματος επεξεργασίας.  Και στην συνέχεια η ανάρτηση των video στoν ιστότοπο του 
www  .  youtube  .  com και η κοινοποίηση τους στην ιστοσελίδα με την μορφή άρθρων.

http://www.youtube.com/


Λέξεις Κλειδία << ιστοσελίδα, εκμάθηση, λογισμικό, ιστόπος ,Wordpress, website, Photoshop, 
Joomla, Drupal, Squarespace,site,  youtube, tutorial, plugins,themes, php,mysql, apache, http>>

2.Abstract
In recent years, the spread of internet is fast and the number of new websites is increased every day,
but the competition and the requirements of companies, users, in order to have more complex and 
more demanding websites, has increased.  Alongside, the need for advertising through the internet is
increased, with result, the need for reliable, fast and above all easy web design is increased too.  
This dissertation is a study on the creation of an interactive website using a content management 
system (CMS - Content Managment System) for the teaching of Photoshop software.  First of all, 
these systems and structures, and their history are explained.  Afterwards, the most popular content 
management systems such as WordPress, Joomla Drupal, SquareSpace are anylised, and then the 
most appropriate CMS according the needs of site is selected, in this case the appropriate CMS is 
WordPress.  For the installation of WordPress a server http, a database and a language scripting 
(PHP) are needed.  In order to install them, Wamp program, which performs group installation of 
the required programs, will be used.  Then a database is created and the installation of WordPress is 
done.  Having made all the above, the choice of Theme is following, based on the needs of the site 
and the structure of site with the pages (Home, About, Contact, Tutorials, Portofolio) , classes 
(tutorials) and articles (posting the video for leraning the use of Photoshop) is done.  Thereafter, 
comes the realization of the  pages, the  categories and the articles according to the structure of the 
website, but also the installation of additives which will be used (Plugins).  With the completion of 
the menu navigation, website is completed.  The educational video for learning the Photoshop 
software with the use of screen capture program and editor program is implemented.  At the end,  
the videos are uploaded at www.youtube.com and they, also, are posted on the website in the form 
of articles.
Keywords << website, elearning, software, ,Wordpress, Photoshop, Joomla, Drupal, 
Squarespace,site,  youtube, tutorial, plugins,themes, php,mysql, apache, http>>

3. Δημιουργία εκπαιδευτικής διαδραστικής πλατφόρμας για την 
διδασκαλία του λογισμικού Photoshop
Σκοπός της πτυχιακής εργασίας είναι να δώσει τα απαραίτητα εφόδια στους φοιτητές ή αποφοίτους 
της σχολής, τα οποία αφορούν το πρόγραμμα του Photoshop, λόγω της πολυπλοκότητας του 
λογισμικού άλλα συνάμα και των πολλών δυνατοτήτων που παρέχει, εξαιτίας της έλλειψης 
ελληνικών εγχειριδίων πάνω σε αυτό, πράγμα που το καθιστά πολύ δύσκολο.  Θα δημιουργηθεί 
ιστοσελίδα και εκπαιδευτικά video τα οποία θα αναλύουν διαφορετικές ενότητες επεξεργασίας.  Θα
γίνει καταγραφεί των video με φωνητική επεξήγηση στην Ελληνική γλώσσα.  Έπειτα θα 
αναρτηθούν τα video στην ιστοσελίδα.  Τέλος, θα υπάρχει η δυνατότητα της σύγχρονης μετάδοσης 
της πτυχιακής εργασίας μέσω livestreaming με την χρήση μιας web cameras.

Για την δημιουργία της ιστοσελίδας θα γίνει χρήση C.M.S (Content Management System).   H 
ανάγκη χρήσης ενός CMS είναι μεγάλη λόγω της απλότητας και της ευχρηστίας που παρέχει το 
σύστημα αυτό, χωρίς την απαραίτητη γνώση γλωσσών προγραμματισμού, καθώς εκτός από τον 
δημιουργό, ο χρήστης μπορεί να διαχειρίζεται πολύ εύκολα το περιεχόμενο της ιστοσελίδας.

3.1. Τι είναι το CMS

Λόγω της ραγδαίας εξάπλωσης του διαδικτύου και του ολοένα αυξανόμενου αριθμού νέων 

http://www.youtube.com/


ιστοσελίδων, έχει αυξηθεί και ο ανταγωνισμός και οι απαιτήσεις των εταιρειών, των χρηστών  για 
ιστοσελίδες πιο σύνθετες και πιο απαιτητικές.  Παράλληλα, όλο και περισσότεροι πελάτες θέλουν 
την διαφήμιση μέσω διαδικτύου, με συνεπεία να αυξηθεί και η ανάγκη για αξιόπιστη, γρήγορη και 
πάνω απ’ όλα πιο εύκολη κατασκευή ιστοσελίδων.  Έτσι λοιπόν, ξεκίνησαν τα Συστήματα 
Διαχείρισης Περιεχομένου ( Content Management system – CMS).  Ας δούμε πιο αναλυτικά τι 
είναι και ποιος ο ρόλος του για την εξέλιξη των ιστοσελίδων.[7][8][9]

Το CMS (Content Management System) είναι μια διαδικτυακή εφαρμογή που επιτρέπει στο 
διαχειριστή τη δημιουργία, τη διαχείριση, τη διανομή, τη δημοσίευση, την παρουσίαση της 
πληροφορίας και την δυνατότητα της διαμόρφωσης της δομής της ιστοσελίδας . [7][9]

Ο διαχειριστής έχει την δυνατότητα να κάνει οποιαδήποτε τροποποίηση στην ιστοσελίδα από 
οποιονδήποτε υπολογιστή, αρκεί να υπάρχει πρόσβαση στο διαδίκτυο με την χρήση ειδικών 
προγραμμάτων, κειμενογράφων (text editors).

Ο όρος δυναμικό περιεχόμενο μιας ιστοσελίδας είναι η δυνατότητα που έχει ο διαχειριστής να 
προσαρμόζει κάθε φορά τις πληροφορίες (προσθέτει , τροποποιεί, διαγράφει).  Οι πληροφορίες 
αυτές μπορεί να είναι : κείμενο, άρθρο, στήλη κατηγορία, εικόνες, video , μουσική κλπ.

3.2. Ιστορική Αναδρομή

Τα Συστήματα Διαχείρισης Περιεχομένου έχουν ύπαρξη περίπου 20 χρόνια, για πρώτη φόρα έγινε 
χρήση για κωδικοποιημένα εσωτερικά δίκτυα υπολογιστών, για βιβλιοθήκες, εφημερίδες και άλλες 
ιστοσελίδες.  Πλέον όμως ο όρος CMS χρησιμοποιείται κατά κύριο λόγο σε web-based συστήματα.

1992-1995 : Με την παρθενική εμφάνιση του Παγκόσμιου Ιστού, τα CMS απασχολούσαν μόνο 
ιστοσελίδες μεγάλων προϋπολογισμών, όπως η amazon.com.  Ο προγραμματισμός αυτών 
βασιζόταν στην γλώσσα προγραμματισμού C++  βασισμένες σε εμπορικές βάσεις δεδομένων όπως 
η Oracle.

1995 : To 1995 δημιουργήθηκε το πρώτο ανοιχτού κώδικα CMS για την Portland Pattern 
Repository.  Το όνομα αυτού “Wiki Wiki” το οποίο δόθηκε από τον προγραμματιστή που σχεδίασε 
το σύστημα.

1997 : Η πρώτη δυναμική μηχανή Html, η PHP, δημιουργήθηκε για πρώτη φορά το 1995, ήταν 
retooled και υλοποιήθηκε για την άμεση αναγνώριση, σταθερότητα και ευκολία χρήσης.

2000 : Το 2000 κυκλοφόρησε η PHP 4.0, η οποία ήταν η μεγαλύτερη αναβάθμιση στην ιστορία της 
PHP και περιλάμβανε ριζικές αλλαγές από τις προηγούμενες εκδόσεις.  Η επανάσταση του 
Διαδικτύου ξεκίνησε στα μέσα του 2000.  Ο συνδυασμός ενός ανοιχτού κώδικα λογισμικού 
(Linux), μιας δωρεάν βάσης δεδομένων, ένα δωρεάν web server (Apache) και μια δωρεάν 
γεννήτρια Html και εύκολη στην χρήση (PHP) έδωσε το κίνητρο στους web developers για την 
δημιουργία αλλά και την συντήρηση πολύπλοκων ιστοσελίδων με ελάχιστο κόστος.  Αυτά τα 
τέσσερα δημιούργησαν ένα ολοκληρωμένο πακέτο κατασκευής ιστοσελίδων με ονομασία LAMP. 

2003 : Δίνεται η δυνατότητα ο κάθε χρήστης  να δημιουργήσει εύκολα μια ιστοσελίδα με την 
χρήση του πακέτου LAMP.[1]

3.3. Ανάλυση του CMS

3.3.1. Η δομή ενός CMS 

 Δημιουργία περιεχομένου

 Διαχείριση περιεχομένου

 Δημοσίευση περιεχομένου



 Παρουσίαση  περιεχομένου 

3.3.2. Δημιουργία περιεχομένου

Ίσως η σημαντικότερη δυνατότητα του CMS.  Οι διαχειριστές μπορούν να δημιουργήσουν εύκολα 
νέα άρθρα χωρίς να γνωρίζουν γλώσσες δημιουργίας ιστοσελίδων.  Η δημιουργία γίνεται μέσα από 
ειδικά διαμορφωμένων κειμενογράφων που μοιάζουν αρκετά με το Word. 

3.3.3. Διαχείριση περιεχομένου 

Υπάρχει η δυνατότητα κατανομής διαφορετικών δικαιωμάτων σε κάθε άτομο-διαχειριστή, ώστε η 
κινήσεις στην ιστοσελίδα να είναι όσο θέλει ο αρχικός διαχειριστής-δημιουργός περιορισμένες και 
έτσι να αποτρέπεται η απώλεια πληροφοριών.

Υπάρχει η δυνατότητα  να ελέγχουμε ανά πάσα στιγμή τις πληροφορίες της σελίδας.  Να 
γνωρίζουμε αναλυτικά ποιος δημιούργησε, επεξεργάστηκε τις πληροφορίες.

3.3.4. Δημοσίευση περιεχομένου

Με την ολοκλήρωση της δημιουργίας του κείμενου ακολουθεί το στάδιο της δημοσίευσης, δηλαδή 
την προβολή του κείμενου στην ιστοσελίδα.  Κατά την φάση της δημιουργίας μπορεί να είναι 
αποθηκευμένο, άλλα όχι όμως δημοσιευμένο στην ιστοσελίδα.

Υπάρχει η δυνατότητα του χρονοπρογραμματισμού, που είναι πολύ σημαντική.  Ο διαχειριστής 
έχει δημιουργήσει διαφορετικά άρθρα-κείμενα, αλλά επιθυμεί την δημοσίευση του κάθε άρθρου σε 
διαφορετικό χρόνο. Έτσι, μέσω του χρονοπρογραμματισμού ρυθμίζει πότε θέλει να δημοσιευθεί το 
κάθε άρθρο.

3.3.5. Παρουσίαση  περιεχομένου

ΤΟ CMS φροντίζει την δημιουργία κάθε φορά νέων links για τα νέα δεδομένα της σελίδας.  
Διευκολύνοντας την πλοήγηση του χρήστη στην σελίδα.

3.4. Οφέλη – Πλεονεκτήματα των CMS

To μεγαλύτερο πλεονέκτημα των CMS είναι η δυνατότητα που μας παρέχουν, να δημιουργούμε 
σελίδες εύκολα με την χρήση κουμπιών, χωρίς να χρειάζεται να χρησιμοποιήσουμε.  Έτσι 
δημιουργούμε  σελίδες εύκολα χωρίς απαραίτητα να γνωρίζουμε PHP, JavaScript, CSS.  Απλά με 
την χρήση Menu που υπάρχει σε κάθε CMS δημιουργούμε τις σελίδες μας.

Ένα μεγάλο πλεονέκτημα είναι ότι υπάρχουν έτοιμα πρότυπα από τα ίδια τα CMS όπου μας 
διευκολύνουν αν δεν θέλουμε να ξεκινήσουμε από την αρχή, πράγμα που είναι αρκετά σύνθετο και 
περίπλοκο.

Τέλος στο διαδίκτυο υπάρχει τεράστια ποικιλία από modules, θέματα ή αλλιώς Templates, τα οποία
έχουν ως στόχο την εμφάνιση της σελίδας μας (Design).

Δεν υπάρχει μόνο ένα CMS, όπως είναι φυσικό.  Έτσι θα  αναλύσουμε τα πιο διαδεδομένα CMS 
και θα αποφασίσουμε ποιο είναι κατάλληλο για το Project μας.



3.5. Ανάλυση των πιο διαδεδομένων CMS

3.5.1. Joomla

Η λέξη Joomla είναι μια λέξη στην γλώσσα των Σουαχίλι που σημαίνει όλοι μαζί.  Το joomla έκανε
την πρώτη του εμφάνιση στις 16 Σεπτεμβρίου 2005, με την έκδοση Joomla 1.0.0 .   Η πρώτη 
έκδοση ήταν βασισμένη στο Mambo 4.5.2.3 σε συνδυασμό με αρκετές διορθώσεις στο περιβάλλον 
διαχείρισης και στην ασφάλεια.  Η επόμενη έκδοση του Joomla! 2.0 ήταν δημιουργημένη από την 
αρχή βασισμένη σε PHP 5.0 .[10]

Η εφαρμογή του, καλύπτει τις ανάγκες για μια προσωπική ιστοσελίδα μέχρι και για  μεγάλες 
εταιρίες με τεράστιες ανάγκες. Οι δυνατότητες του είναι πάρα πολλές άλλα συνάμα είναι πολύ 
φιλικό και ευέλικτο.  Είναι ένα δωρεάν και ανοιχτού κώδικα CMS γραμμένο σε PHP και 
χρησιμοποιεί  αντικειμενοστραφή προγραμματισμό αποθηκεύοντας δεδομένα σε αποθήκες 
δεδομένων.

Τι μπορεί να δημιουργηθεί με την χρήση του Joomla

 Ηλεκτρονικό εμπόριο (e-shop) και online κρατήσεις (booking)

 Προσωπικές ιστοσελίδες

 Εφαρμογές και ιστοσελίδες για το κράτος

 Ιστοσελίδες και εταιρικά Web Portals και ενδοδίκτυα 

 Περιοδικά και εφημερίδες σε ηλεκτρονική μορφή

 Ιστοσελίδες για μικρές άλλα και μεγάλες επιχειρήσεις 

Κύρια Χαρακτηριστικά

Διαχείριση Χρηστών

Το Joomla παρέχει ένα σύστημα διαχείρισης χρηστών, που επιτρέπει ο κάθε χρήστης να έχει 
διαφορετικά τύπου δικαιώματα στην επεξεργασία, δημιουργία, διαγραφή και γενικά στην 
διαχείριση. Υπάρχουν εννέα  διαφορετικές ομάδες δικαιωμάτων στην πλατφόρμα.

Διαχείριση Διαφήμισης

Εικόνα 1: Logo Joomla



Υπάρχει η δυνατότητα δημιουργίας ειδικών Banner στην ιστοσελίδα σε σημεία που έχει επιλέξει ο 
διαφημιζόμενος να προβάλετε χρησιμοποιώντας την διαχείριση Βanner.

Δημιουργία Δημοσκοπήσεων

Το Joomla παρέχει την δυνατότητα δημιουργίας δημοσκοπήσεων για θέματα που αφορούν τους 
χρήστες ή την ίδια την ιστοσελίδα με σκοπό την καλύτερη λειτουργία της ιστοσελίδας.

Διαχείριση περιεχομένου

Το Joomla όπως και όλα τα CMS οργανώνει το περιεχόμενο με την χρήση μίας ιεραρχίας.  Το  
Joomla υλοποιείται  με την χρήση τριών επίπεδων ιεραρχίας.  Η ύπαρξη της ιεραρχίας δεν βοηθάει 
μόνο τους διαχειριστές αλλά εξυπηρετεί και στην καλύτερη πλοήγηση των χρηστών στην 
ιστοσελίδα. 
Τα τρία επίπεδα της ιεραρχίας του Joomla είναι :

 Ενότητες :  Όπου βρίσκονται στο πρώτο επίπεδο της ιεραρχίας και περιλαμβάνουν 
κατηγορίες.

 Κατηγορίες : Βρίσκονται σε ενδιάμεσο επίπεδο της ιεραρχίας και περιλαμβάνουν άρθρα.

 Άρθρα :  Βρίσκονται στο τελευταίο επίπεδο της ιεραρχίας τα οποία αποτελούνται από 
περιεχόμενο 

Τρόπος εγκατάστασης και Λειτουργίας

Η εγκατάστασή γίνεται μέσω ενός κεντρικού υπολογιστή web server και προαπαιτεί την  
εγκατάσταση ενώ Εξυπηρετητή, μιας βάσης δεδομένων και της PHP. 

Δυνατότητες και Επεκτάσεις 
Το  Joomla είναι μια εφαρμογή, η οποία βασίζεται στην νοοτροπία των δωρεάν και ανοιχτού 
κώδικα, έτσι υπάρχουν πάρα πολύ προγραμματιστές που ασχολούνται με την εξέλιξη του και με την
δημιουργία Επεκτάσεων. [Εικόνα 2] Τέλος υπάρχουν πάρα πολλά δωρεάν Templates τα οποία 
διαμορφώνουν την εμφάνιση για την κάθε ιστοσελίδα.[4][6]

Εικόνα 2



3.5.2. WordPress

Το WordΡress έκανε την εμφάνιση του το 2004 με σκοπό την ενίσχυσης της τυπογραφίας, οι 
χρήστες του ήταν ελάχιστοι και ο κώδικας δεν ξεπερνούσε το ένα κομμάτι.  Σήμερα όμως 
θεωρείται η καλύτερη αυτοφιλοξενούμενη πλατφόρμα CMS στο κόσμο.  Το WordPress είναι της 
ίδιας φιλοσοφίας με το Joomla ελεύθερου και ανοιχτού κώδικας CMS.  Είναι γραμμένο σε PΗΡ και
ΜySql.  Θεωρείται το πιο ευρέως διαδεδομένο, λόγω της αρχιτεκτονικής του, η οποία περιλαμβάνει
πρόσθετες λειτουργίες και βασίζεται σε σύστημα προτύπων, διευκολύνοντας έτσι τους χρήστες .

Ιστορική αναδρομή :

2003 : Ο  Matt Mullenweg, Ryan Boren, Donncha O Caoimh έδωσαν την πρώτη ιδέα για τη 
δημιουργία του WordΡress σαν b2/cafelog και η χρήση του γίνεται από το 15% των 1.000.000 
μεγαλύτερων website σε ολόκληρο τον κόσμο έως και σήμερα.
2004 : Πλήθος χρηστών του ανταγωνιστικού λογισμικού Movable Type αρκετά επηρεαζόμενοι, 
κατευθύνθηκαν στο WordΡress, λόγω του ότι η Six Apart άλλαξε τους όρους της άδειας χρήσης της
Movable Type. Μέσα από αναφορές της αγοράς που είχαν γίνει για τα "Συστήματα Διαχείρισης 
Περιεχομένου Ανοικτού Κώδικα" μέχρι τον Οκτωβρίου του 2009 είχε γίνει το WordΡress η 
καλύτερη επιλογή ανάμεσα σ' αυτά τα συστήματα. 

Αρχικά ξεκίνησε σαν ένα σύστημα για blogging ,άλλα πλέον σήμερα χρησιμοποιείται σαν ένα 
ολοκληρωμένο σύστημα διαχείρισης περιεχόμενου με την δυνατότητα χρήσης plugins,widgets και 
θεμάτων . 

Βασικά Χαρακτηριστικά του WordΡress:
Απλότητα 

Η απλότητα παρέχει την δυνατότητα να κοινοποιούνται τα άρθρα πολύ εύκολα και γρήγορα.  Το  
WordΡress είναι έτσι δομημένο ώστε η κάθε κίνηση στον ιστότοπο να είναι ξεκάθαρη και 
καθοδηγημένη χωρίς ενδιάμεσα εμπόδια.
Ευελιξία

Το WordPress παρέχει την δυνατότητα δημιουργίας κάθε είδους ιστοσελίδας (προσωπική 
ιστοσελίδα, blog, μέχρι και ιστοσελίδες για την κυβέρνηση). Με την χρήση θεμάτων και plugin που
υπάρχουν στην πλατφόρμα να υλοποιηθεί το design της ιστοσελίδας.
Διαχείριση Χρηστών

Κάθε μέλος της ιστοσελίδας απαιτεί διαφορετική πρόσβαση στην ιστοσελίδα . Το WordPress έχει 

Εικόνα 3: WordPress Logo



δημιουργήσει κατηγορίες μελών ανάλογα με τις απαιτήσεις για τα δικαιώματα που υπάρχουν. 
(διαχειριστές, συντάκτες, συγγραφείς, κλπ)

Σύστημα Θεμάτων 

Το WordΡress έχει προεγκατεστημένα δύο θέματα, αλλά στην αντίστοιχη κατηγορία υπάρχει 
κατάλογος με πολλά θέματα για την επιλογή της διακόσμησης της σελίδας.

Χρήση   Plugins   

Στην αντίστοιχη κατηγορία στο Dashboard του WordPress μπορούμε να επιλέξουμε πολλά χρήσιμα
Plugins για την ιστοσελίδα μας.  Δημιουργία Gallery, σύνδεσης ιστοσελίδας με τα μέσα κοινωνικής 
δικτύωσης, ημερολόγια, αλληλογραφία και φόρμες επικοινωνίας.
Κοινότητα 

Ένα από τα κύρια χαρακτηριστικά που θέτουν το WordPress ένα από τα καλύτερα CMS συστήματα
είναι η online υποστήριξη.  Με την χρήση τoυ forum που διαθέτει ή την παρακολούθηση 
Wordcamp, Μeetup, η γνωριμία με το WordPress γίνεται ευκολότερη.

Πολυγλωσσική δυνατότητα
Το WordPress είναι μεταφρασμένο σε περισσότερες από 70 γλώσσες, μια από αυτές είναι και τα 
ελληνικά.  Έτσι δεν είναι αναγκαία η γνώση αγγλικών για την δημιουργία μιας ιστοσελίδας.[5][6]

Εικόνα 4: WordPress Dashboard



Δυνατότητες
Η διαμόρφωση του  γραφικού περιβάλλοντος υλοποιείται μέσα από την εφαρμογή, χωρίς να 
χρειάζεται η παρέμβαση στον κώδικα του πρότυπου.  Εξαιτίας των πρόσθετων λειτουργιών που 
υπάρχουν εγκατεστημένες επιτρέπουν στους χρήστες την αξιοποίηση αυτών για να πετύχουν το 
επιθυμητό αποτέλεσμα.

Επίπεδο Γνώσεων

Το WordPress απευθύνεται σε αρχαρίους χρήστες έχοντας ελάχιστες γνώσεις κειμενογράφων, λόγω 
της απλότητας  που παρέχει  και της καλής ηλεκτρονικής υποστήριξης που διαθέτει.

Εικόνα 5: WordPress Widgets



3.5.3. Drupal

Το Drupal ένα CMS όπως και τα προηγούμενα ελεύθερο και ανοιχτού κώδικα γραμμένο και αυτό, 
σε  γλώσσα προγραμματισμού PHP.  Το Drupal παρέχει στον διαχειριστή  την δυνατότητα 
τροποποίησης και διαμόρφωσης του γραφικού περιβάλλοντος χωρίς την απαραίτητη γνώση 
προγραμματισμού.  Το Drupal έχει την δυνατότητα να εκτελείται σε διαφορετικά λειτουργικά 
συστήματα όπως Windows, Mac OS X, Linux, FreeBSD, τα οποία υποστηρίζουν  Apache HTTP 
Server ,γλώσσα  προγραμματισμού PΗΡ και μιας βάσης δεδομένων για την αποθήκευση των 
δεδομένων.[3][6]

Ιστορική Αναδρομή

Το ξεκίνημα του Drupal έγινε από τον Dries Buytaert το 1999.  Το ενδιαφέρον για την χρήση και 
συμβολή στην Drupal αυξανόταν σημαντικά, έτσι το έργο έγινε ανοιχτού κώδικα.  To Drupal.org 
έκανε την πρώτη του εμφάνιση στο διαδίκτυο το 2001,και η ραγδαία ανάπτυξη και εξέλιξη του 
πραγματοποιήθηκε το 2005 και έπειτα. 

Χρησιμότητα του Drupal

Ενδοδίκτυα/Εταιρικές ιστοσελίδες

Εκπαίδευση

Πολυμέσα, Τέχνες

Ιστοσελίδες κοινοτήτων

Ιστοσελίδες κοινωνικής δικτύωσης

Επιστημονικοί ιστότοποι

Περιοδικά[6]

Επίπεδο Γνώσεων

 Εικόνα 6: Drupal Logo



Το Drupal παρόλο της σύνθετης προγραμματιστικής υποδομής που έχει, η ύπαρξη 
προγραμματιστικών γνώσεων δεν είναι απαραίτητη .

3.5.4. Squarespace

Εικόνα 7: Drupal Content Management

Εικόνα 8: SquareSpace Logo



Το Squarespace είναι ένα SaaS Based CMS, το οποίο αποτελείται από την δημιουργία 
ιστοσελίδας, blog και την φιλοξενία της ιστοσελίδας σε ένα πακέτο.

Saas – Software as a Product μια καινούργια καινοτομία, η οποία έχει ως σκοπό την 
δημιουργία ενός προϊόντος και την φιλοξενία του ταυτόχρονα (hosting).  Η αγορά του 
λογισμικού συνοδεύεται με την φιλοξενία.

Στην περίπτωση του Squarespace, με την δημιουργία ενός λογαριασμού υπάρχει μια 
δοκιμαστική περιήγηση για 14 ημέρες και έπειτα το κόστος  για την συντήρηση και 
φιλοξενία ξεκινάει από τα 8$ το μήνα.

Το κόστος για μια άλλη ιστοσελίδα με διαφορετικό CMS ξεκινάει από τα 4$ ανά μήνα μόνο η 
φιλοξενία .

Επίπεδο Γνώσης

Το Squarespace είναι πολύ εύχρηστο και εύκολο στην κατανόηση άλλα και στην 
σχεδίαση χάρης στην ποικιλία των θεμάτων που υπάρχουν και στην τροποποίηση είναι 
πολύ εύκολη. [εικόνα 9]

Δυνατότητες

Μεγάλη ποικιλία θεμάτων για την δημιουργία της αρχικής σχεδίασης του ιστότοπου. Παρέχει 
επίσης την εύκολη δημιουργία e-shop και blogs.  Επίσης στην πλατφόρμα υπάρχει 
πρόγραμμα παρακολούθησης αναλυτικής επισκεψιμότητας.

Τέλος όλα τα θέματα είναι κατασκευασμένα με την τεχνολογία Responsive design μιας
και τα τελευταία χρόνια, η χρήση των κινητών τηλεφώνων και των Tablets έχει 
αυξηθεί, έτσι η ιστοσελίδα προσαρμόζεται κάθε φόρα με την συσκευή του χρήστη.

Κύριο χαρακτηριστικό η εύκολη πρόσβαση από τον ιστότοπο : w ww.squarespace.com.

Σε αντίθεση με όλα τα προηγούμενα CMS δεν χρειάζεται η γνώση και η εγκατάσταση

PΗΡ, βάση Δεδομένων και http Server, παρέχονται προ εγκαταστημένα και ο 
διαχειριστής δεν έχει καμία επαφή, πράγμα που το κάνει ακόμη ποιο εύκολο και 
ασφαλές.[2]

Δημιουργία καινούργιας σελίδας

Εικόνα 9: SquareSpace Menu

http://www.squarespace.com/


Καταλήγοντας,το συμπέρασμα από την μελέτη των ποιών διαδεδομένων CMS είναι ,ότι ο χρήστης 
είναι αυτός που αποφασίζει πιο CMS θα χρησιμοποιήσει με βάση τις γνώσεις του και το πλάνο του 
για την ιστοσελίδα. Για την της διαδραστικής πλατφόρμας για την διδασκαλία του λογισμικού 
Photoshop ,προτεινόμενα CMS είναι το Wordpress και το foursquare.Όμως το Wordpress υπερτερεί
του Squarespace ,καθώς είναι πολύ διαδεδομένο στην Χώρα μας και γενικά στο Κόσμο,με 
αποτέλεσμα η υπάρχει περισσοτέρων εκπαιδευτικών υλικών .Ακόμη το Squarespace έχει 
περιορισμό στο αποθηκευτικό χώρο που παρέχεται από την εταιρία με το Πακέτο της Προσωπικής 
χρήσης .

4.Δημιουργία ιστοσελίδας με την χρήση του WordPress

WordPress είναι ένα εντελώς δωρεάν εργαλείο που χρησιμοποιείται για τη δημιουργία δυναμικών 
ιστοσελίδων. Κύριο χαρακτηριστικό είναι η απλότητα και ευρεία χρήση του σε όλους τους τομείς 
που σχετίζονται με την δημιουργία ιστοσελίδων.

4.1. Εισαγωγή στο WordPress :

Η εγκατάσταση του Wordpress απαιτεί την προ εγκατάσταση μιας βάσης δεδομένων(MySql),ενός 
Http Server και την Php [12] με την χρήση Wamp Server. [Εικόνα 10][14]

Wamp είναι μία συλλογή από Apache,PHP και MySql ομαδοποιημένα και εύκολα για εγκατάστασή
για υπολογιστές με λογισμικό Windows ,ενώ για λογισμικό Mac υπάρχει το αντίστοιχο Mamp.

.http  ://  www  .  wampserver  .  com  /  en  /

4.1.1. Εγκατάσταση Wamp Server 

Για την εγκατάσταση  του wamp , προαπαιτείτε η λήψη του λογισμικού .Με την επίσκεψη στην 
ιστοσελίδα .http  ://  www  .  wampserver  .  com  /  en  / .Επιλέγουμε την έκδοση του λογισμικού Windows (64
-bit ή 32-bit).[11][14]

Με την Ολοκλήρωση της λήξης ,επόμενο βήμα η εκτέλεση του προγράμματος εγκατάστασης ,

Λίγο πριν την ολοκλήρωση της εγκατάστασης θα ζητηθεί η τοποθεσία προγράμματος περιήγησης 
στο Διαδίκτυο και έπειτα ολοκληρώνεται η εγκατάσταση. 

Εικόνα 10: Wamp

http://www.wampserver.com/en/
http://www.wampserver.com/en/


4.1.2. Δημιουργία βάσης δεδομένων.

To wamp περιλαμβάνει το phpMyAdmin,μία εφαρμογή βασισμένη στο ιστότοπο για την διαχείριση
βάσεων δεδομένων . [13][14]

Με το άνοιγμα του phpMyAdmin [Εικόνα 11] θα δημιουργηθεί μια νέα   βάση δεδομένων [Εικόνα 
12]για Wordpress . 

Εικόνα 11

Εικόνα 12: Δημιουργία Βάσης Δεδομένων



4.1.3. Εγκατάσταση Wordpress .

Για την εγκατάσταση  του wordpress , προαπαιτείτε η λήψη του λογισμικού από 
https  ://  wordpress  .  org  / . Με το ολοκλήρωση της λήξης απαιτείται  η εξαγωγή του αρχείου zip 
καιαντιγραφή του φακέλου στην διεύθυνση C:\wamp\www .Έπειτα μετά το άνοιγμα ενός 
περιηγητή γίνεται η τοποθέτηση της διεύθυνσης.[14]

 Http  ://  localhost  /  wordpress ( όπου wordpress το όνομα του φακέλου )

Στο επόμενο βήμα γίνεται η συμπλήρωση των στοιχειών της βάσης δεδομένων. [Εικόνα 13]

Για την Ολοκλήρωση της εγκατάστασης είναι απαραίτητη η συμπλήρωση το βασικών στοιχείων 
και έπειτα η σύνδεση στην σελίδα.  [Εικόνα 14]

Εικόνα 13: Wordpress Install

http://localhost/wordpress
https://wordpress.org/


4.2. Επιλογή Θέματος και εγκατάστασης του στο WordPress

 Για την καλύτερη υλοποίηση της ιστοσελίδα χρειάζεται η επιλογή ενός θέματος με βάση τις 
ανάγκες της σελίδας. Απαραίτητα στοιχεία για την ιστοσελίδα είναι : 

 Σύνδεση με τα Μέσα κοινωνικής δικτύωσης για την προώθηση άλλα και την επικοινωνία με
τους χρήστες των μέσων αυτών.

 Δημιουργία Portofolio για την προβολή των φωτογραφιών ώστε να γίνεται χρήση μεσώ 
ιδικού συνδέσμου σε άλλες σελίδες  , η ύπαρξη σελιδοποίησης των φωτογραφιών είναι 
αναγκαία. Διαχωρισμός σε Κατηγορίες (Πορτρέτα,τοπία,φύση,φαγητό και άλλα).

 Ανάγκη χρήσης Responsive θέματος. Είναι μια ευέλικτη βάση με το  σύστημα που έχει την 
δυνατότατα προσαρμογής της ιστοσελίδας σε κινητές συσκευές ,η οποιοδήποτε άλλο μέσω 
προβολής της σελίδας.

 Στο διαδίκτυο υπάρχουν πολλά θέματα διαθέσιμα. Η καλύτερη επιλογή για την ιστοσελίδα είναι η 
Enfold .

Εγκατάσταση Θέματος

Η Εγκατάσταση του θέματος είναι απλή και μπορεί να γίνει με δύο τρόπους

Εικόνα 14: Φόρμα Βασικών Στοιχείων Wordpress



1. Προσθήκη θέματος από τον Πίνακα έλεγχου της σελίδας  [Εικόνα15]. Στην συνέχεια γίνεται

η επιλογή Προσθήκη Νέου και έπειτα μεταφόρτωση θέματος .Στην Επιλογή αρχείου γίνεται
η τοποθέτηση της διεύθυνσης του θέματος σε αρχείο .zip.Τέλος εγκατάσταση και 
ενεργοποίηση.

2. Ο δεύτερος τρόπος υλοποιείται με την εξαγωγή του συμπιεσμένου αρχείου του θέματος και 
η αντιγραφή του και επικόλληση στην τοποθεσία C:\wamp\www\wordpress\wp-
content\themes  [Εικόνα 16].

Τέλος η ενεργοποίηση του θέματος γίνεται από τον πίνακα ελέγχου /εμφάνιση/θέματα .

4.3. Σχεδίαση Δομής Ιστοσελίδας.

H Δομή της ιστοσελίδας θα είναι βασισμένη στον σκοπό δημιουργίας της,

Η ύπαρξη της αρχικής σελίδας (Home ) απαραίτητη,η χρήση ενός Portofolio ώστε ο κάθε 
επισκέπτης να έχει την δυνατότητα να παρακολουθήσει το υλικό στο οποίο θα διδαχθεί για την 
εκμάθηση του λογισμικού Photoshop.Το ενδιαφέρον της αρχικής σελίδας  θα πρέπει να είναι 
επικεντρωμένο στην εκμάθηση του λογισμικού το οποίο θα βρίσκεται στην σελίδα Tutorials .

Μια σελίδα Επικοινωνίας (Contact) οπού ο χρήστης θα μπορεί να έρθει σε επαφή με τους 
διαχειριστές της σελίδας. Η σελίδα αυτή θα περιλαμβάνει μια φόρμα επικοινωνίας μέσω email

Ανάγκη υπάρξεις σελίδας για επικοινωνία μέσω ιδικής φόρμας επικοινωνίας. Και τέλος ύπαρξη 
σελίδας About  . Είναι συμπαντικό ο επισκέπτης να γνωρίζει πληροφορίες για το προσωπικό της  
ιστοσελίδας.

Καταλήγοντας ότι το μενού πλοήγησης της ιστοσελίδας θα περιλαμβάνει :

 Κεντρική Σελίδα 

 Portofolio

 Tutorials

Εικόνα 15: Επιλογή Θέματος

Εικόνα 16: Φάκελος Θέματος



 About 

 Contact

4.4. Δημιουργία Portofolio 

Η Χρήση ενός Portofolio είναι πολύ σημαντική οι χρήστες θα έχουν την δυνατότητα να δουν 
φωτογραφίες , οι οποίες θα είναι κατηγοριοποιημένες με βάση το θέμα ( Πορτρέτα, Τοπία, Φαγητό ,
και άλλα) .  

Το Θέμα που έχει επιλεχθεί  περιλαμβάνει στον πίνακα ελέγχου  μια κατηγορία Portofolio Items  
[Εικόνα 17] το οποίο παρέχει στον σχεδιαστή – δημιουργό να διαχειριστή σε αυτή την ενότητα το 
Portofolio και τις κατηγορίες του. 

4.4.1. Δημιουργία Κατηγοριών Portofolio

Σε αυτή την ενότητα θα υλοποιηθεί η κατηγοριοποίηση των φωτογραφιών με βάση το θέμα τις 
φωτογραφιών που θα περιλαμβάνει το κάθε Portofolio Item

Εικόνα 17: Portofolio Menu

Εικόνα 18: Καρτέλα Portofolio Items 



Στα παραπάνω πεδία  [Εικόνα 18]συμπληρώνονται τα στοιχειά που θα εμφανίζονται αργότερα στην
ιστοσελίδα .

Όνομα :

Σε αυτό το πεδίο γίνεται η καταγραφή του ονόματος της κατηγόριας που θα δημιουργηθεί .

Σε κάθε καινούργιο Portofolio Item ο δημιουργός θα επιλεγεί μεταξύ άλλων σε ποιες κατηγορίες θα
ανήκει  .

Σύντομο όνομα :

Αυτό το πεδίο δεν είναι υποχρεωτικό για συμπλήρωση,χρησιμοποιείται για τις διευθύνσεις 
URL,και συνήθως περιέχει μόνο λατινικούς πεζούς χαρακτήρες.

Γονέας : 

Σε αυτό το πεδίο γίνεται επιλογή, αν η κατηγορία που θα δημιουργηθεί είναι υποκατηγορία κάποιας
άλλης   που έχει ήδη δημιουργηθεί .

Περιγραφή :

Αυτό το πεδίο δεν είναι υποχρεωτικό για συμπλήρωση, η περιγραφή δίνει την δυνατότητα για την 
ενημέρωση στο περιεχόμενο αυτής της κατηγορίας.

Υλοποίηση κατηγοριών  

1) Πορτρέτα

2) Τοπία

Εικόνα 19: Καρτέλα Portofolio Categories



3) Φαγητό

4) Νυχτερινή Διασκέδαση

Εικόνα 20

Εικόνα 21



4.4.2. Δημιουργία Portofolio Items 

Σε αυτή την ενότητα θα υλοποιηθεί η δημιουργία Portofolio Items ,τα οποία θα περιλαμβάνουν 
φωτογραφίες και στην συνέχεια η κατηγοριοποίηση τους ,στις κατηγορίες που υλοποιήθηκαν 
παραπάνω.[Εικόνα 23]

Η ενότητα αυτή είναι πολύ σημαντική για την σελίδα Portofolio.Εδώ γίνεται η σχεδίαση στον 

Εικόνα 22

Εικόνα 23: Καρτέλα Portofolio Entry



τρόπο εμφάνισης των Portofolio Items. Θα γίνει χρήση ενός πρόσθετου για την σχεδίαση της δομής
με τίτλο Advanced Layout Editor . Το Θέμα που έχει επιλεχθεί έχει προ εγκατεστημένο το 
πρόσθετο αυτό.

Τίτλος Portofolio item

Στο πρώτο πεδίο με τίτλο <<Δώστε τον τίτλο εδώ>> . Γίνεται η καταγραφή του τίτλου που θα 
εμφανίζεται το Portolio αυτό.

Υλοποίηση δομής των Portofolio Items Για την Υλοποίηση της δομής θα γίνει χρήση του 
πρόσθετου Advanced layout Editor.[Εικόνα 24]

Στο σημείο αυτό θα δημιουργηθεί μια Gallery από τις φωτογραφίες που θα περιέχει το Portofolio 
item που υλοποιείται . Με την χρήση του πρόσθετου στην ενότητα Media Elements γίνεται η 
επιλογή Mansory Gallery.  [Εικόνα 25]

Ανέβασμα φωτογραφιών για το Portofolio

Εικόνα 24

Εικόνα 25: Mansory Gallery



Γίνεται επιλογή Add/edit Gallery ,έπειτα Upload Files  και με την χρήση του οδηγού πλοήγησης 
,γίνεται η επιλογή των φωτογραφιών για ανέβασμα. [Εικόνα 26]

Όταν το ανέβασμα των φωτογραφιών ολοκληρωθεί γίνεται αποθήκευση. Έτσι οι Gallery έχει 
δημιουργηθεί. [Εικόνα 27]

Δημιουργία Ενότητας Περιγραφής για  Portofolio.

Μέτα την δημιουργία της συλλογής με τις φωτογραφίες όπου θα περιέχει το συγκεκριμένο 
Portofolio,σειρά έχει η δημιουργία μιας ενότητας στο Portofolio με πληροφορίες σχετικά με την 
συλλογή. Για την δημιουργία της ενότητας αυτής θα γίνει χρήση του πρόσθετου Avia layout 
Builder και πιο συγκεκριμένα στην καρτέλα Layout Elements .Για να δεσμεύσει όλη η περιοχή 
πάνω από την συλλογή θα γίνει χρήση ενός Grid row.

Εικόνα 26: Ανάρτηση Φωτογραφιών

Εικόνα 27



H χρήση του Grid row έγινε για την δεσμεύσει του χώρου πάνω από την συλλογή ώστε να μην 
υπάρξει καμία εμπλοκή με την συλλογή σε οποιοδήποτε διακομιστή ή συσκευή γίνει η προβολή της
ιστοσελίδας .[Εικόνα 28]Έπειτα στο πρώτο κομμάτι του Grid Row (1/2) θα δημιουργηθεί με την 
βοήθεια του πρόσθετου  στην καρτέλα Content Elements, ένα Special Heading [Εικόνα 29]για τον 
τίτλο και ένα Text Block [Εικόνα 30]για τις λεπτομέρειες  της περιγραφής.  

Εικόνα 28: Avia Layout Builder

Εικόνα 29: Special Heading



Τέλος για την καλύτερη εμφάνιση του Portofolio item στην σελίδα Portofolio,αναγκαίο είναι η 
ύπαρξη Επιλεγμένης Εικόνας δηλαδή μια φωτογραφία όπου θα είναι το εξωφύλλου .

Αποθήκευση προτύπου για την χρήση σε κάθε Portofolio Item 

Για την διευκόλυνση των διαχειριστών και την καλύτερη εμφάνιση της ιστοσελίδας γίνεται 
αποθήκευση του προτύπου στην Επιλογή Templates .[Εικόνα 31]

Επιλογή Κατηγοριών και δημοσίευση.

Κάθε Portofolio Item  που δημιουργείται  ανήκει σε κάποιες κατηγορίες ανάλογα με το θέμα .Έτσι 
δίνεται η επιλογή στο χρήστη να επιλέξει στην Σελίδα Portofolio ποίες κατηγορίες να 
προβάλλονται .[Εικόνα 32]

Εικόνα 30: Text Block

Εικόνα 31: Αποθήκευση Template



Τέλος αφού έχουν πραγματοποιηθεί όλα τα παραπάνω γίνεται δημοσίευση.[Εικόνα 33]

4.4.3. Δημιουργία Σελίδας Portolio

Μέτα την δημιουργία των κατηγοριών  και των Portofolio Items ,σειρά έχει η εμφάνιση αυτών στην
σελίδα Portofolio.Τα Cms συστήματα χαρακτηρίζονται για την δυναμικότητα. Έτσι ότι καινούργιο 
Portofolio Item δημιουργείται θα πρέπει αυτόματα να εμφανίζεται στην σελίδα Portofolio.

Εικόνα 32: Portofolio Gallery List

Εικόνα 33: Δημοσίευση



Aυτο υλοποιείται με την χρήση του πρόσθετου .Στην καρτέλα Content Elements με την επιλογή 
Mansory.[Εικόνα 34]

Για να γίνει η επιλογή εμφάνισης των κατηγοριών του Portofolio , μετά το άνοιγμα του Mansory 

γίνεται η επιλογή Portofolio Entries.Στην συνέχεια η επιλογή όλων των κατηγοριών είναι 
απαραίτητη .Τέλος μετά την δημοσίευση η σελίδα είναι έτοιμη. [Εικόνα 35]

4.5. Δημιουργία Κεντρικής Σελίδας(Home)

Σε αυτήν την ενότητα θα υλοποιηθεί η κεντρική σελίδα της ιστοσελίδας( Home Page).
Σκοπός της πτυχιακής εργασίας είναι η δημιουργία ιστοσελίδας για την διδασκαλία του λογισμικού 

Εικόνα 34: Δημιουργία Σελίδας Portofolio

Εικόνα 35: Επιλογή κατηγοριών για εμφάνιση



Photoshop.Με το θέμα της πτυχιακής θα δημιουργηθεί μια αρχική σελίδα απλή και ξεκάθαρη .

Αναγκαία είναι η ύπαρξη του Menu πλοήγησης . Θα υπάρχει ακόμη ένα Fullscreen Slider με 
φωτογραφίες κάποιες προεπιλεγμένες φωτογραφίες  στο παρασκήνιο. Τέλος στο Slider  αυτό θα 
υπάρχουν δυο κουμπιά-σύνδεσμοι  που το ένα θα παραπέμπει στα Tutorials και το άλλο στο 
Portofolio.Με αυτόν τον τρόπο ο κάθε χρήστης θα επικεντρώνεται εκεί.

4.5.1. Δημιουργία Κεντρικής Σελίδας

Από τον Πίνακα ελέγχου της πλατφόρμας Wordpress γίνεται επιλογή Σελίδες και στην συνέχεια 
δημιουργία σελίδας.[15]

Τίτλος Σελίδας

Στο πρώτο πεδίο γίνεται η καταγραφή του Τίτλους. Ο ποιο διαδεδομένος Τίτλος αρχικής Σελίδας 
είναι το Home. 

Υλοποίηση Fullscreen Slider

Στην συνέχεια θα γίνει χρήση του πρόσθετου Avia layout Builder για την δημιουργία του Slider.

Από την καρτέλα Media Elements θα χρησιμοποιηθεί το Fullscreen Slider[Εικόνα 36].

Στην συνέχεια από το Menu  που εμφανίζεται γίνεται η προσθήκη των φωτογραφιών για εμφάνιση 
στο Slider.[Εικόνα 37]

Για την δημιουργία των κουμπιών-συνδέσμων επιλέγουμε την πρώτη φωτογραφία.

Στη καινούργια καρτέλα που εμφανίζεται γίνεται επιλογή του Caption.

Στο πεδίο Caption Title καταχωρείται ο τίτλος που θα εμφανίζεται.

Στο πεδίο Caption Text καταχωρείται μια σύντομη περιγραφή ή ένα κείμενο που θέλουμε να 
εμφανίζεται .Κανένα από τα παραπάνω πεδία δεν είναι υποχρεωτικά.

Στο πεδίο apply a link or buttons to the slide? Γίνεται η επιλογή attach two Buttons.

Εικόνα 36: Avia Layout Builder - Media Elements

Εικόνα 37: Προσθήκη Φωτογραφιών



Και στην συνέχεια στο Button 1 label και Button 2 Label καταχωρείται ο Τίτλος των δύο κουμπιών 
που θα εμφανίζεται.

Στο πεδίο Button 1 Color και Button 2 Color γίνεται η επιλογή των χρωμάτων που θα υπάρχει ως 
παρασκήνιο .

Και τέλος στο πεδίο Button 1 Link και Button 2 Link οι σύνδεσμοι που θα παραπέμπουν τα 
κουμπιά. Με την ολοκλήρωση όλων των ρυθμίσεων  και η αποθήκευση,σειρά έχει η δημοσίευση 
της σελίδας. [Εικόνα 38]

4.6. Δημιουργία Σελίδας για την διδασκαλία του Photoshop (Tutorials)

Στην ενότητα αυτή θα δημιουργηθεί η σελίδα στην οποία θα γίνονται αναρτήσεις για την 
διδασκαλία του Photoshop.Η αναρτήσεις θα γίνονται με την δημιουργία άρθρων για το κάθε 
εγχειρίδιο – Tutorial .Ώστε κάθε άρθρο που θα ανήκει στην κατηγορία tutorials αυτόματα θα 
εμφανίζεται στην σελίδα Tutorials.Για την υλοποίηση αυτής της σελίδας θα γίνει η δημιουργία μιας
κατηγορίας για την κατηγοριοποίηση των άρθρων , και η προσθήκη ενός Post slider που θα 
εμφανίζει  τα άρθρα – Tutorials από την κατηγορία tutorial.[15]

Εικόνα 38



4.6.1. Δημιουργία κατηγορίας Tutorial.

Οι κατηγορίες ανήκουν στην ενότητα των άρθρων με τα οποία σχετίζονται. Κάθε άρθρο ανήκει σε 
μια ή περισσότερες κατηγορίες. 

Από τον Πίνακα έλεγχου του Wordpress γίνεται επιλογή κατηγορίες .

Στο πεδίο Όνομα γίνεται καταγραφή του ονόματος της Κατηγορίας

Στο πεδίο σύντομο όνομα γίνεται καταγραφή συνήθως το όνομα με πεζούς λατινικούς χαρακτήρες.

Στο πεδίο Γονέας γίνεται επιλογή αν η κατηγορία που θα δημιουργηθεί είναι υποκατηγορία κάποιας
άλλης. Στην προκειμένη περίπτωση η κατηγορία Tutorial βρίσκεται στην κορυφή της ιεραρχίας .
[Εικόνα 39][16]

Στο πεδίο περιγραφή γίνεται μια αναφορά στο τι περιλαμβάνει αυτή η κατηγορία. Η περιγραφή δεν 
εμφανίζεται αλλά παίζει σημαντικό ρόλο στις μηχανές αναζήτησης.

Τέλος  με την προσθήκη κατηγορίας ολοκληρώνεται η κατηγορία και είναι έτοιμη για χρήση.

4.6.2. Δημιουργία Σελίδας Tutorials

Η δημιουργία της σελίδας για τον αυτόματο συγχρονισμός με τα καινούργια άρθρα απαιτεί την 
χρήση του προσθέτου Avia layout Builder. [15]

Για την δημιουργία της σελίδας γίνεται επιλογή από το πίνακα έλεγχου  της καρτέλας σελίδες και 
στην συνέχεια Νέα σελίδα. 

Από το πρόσθετο γίνεται επιλογή της καρτέλας  Post slider .Μέτα το άνοιγμα του Post Slider στην 
καρτέλα που εμφανίζεται γίνεται επιλογή της κατηγορίας που θα εμφανίζεται ,ποιο συγκεκριμένα 
της κατηγορίας tutorials.[Εικόνα 40]

Εικόνα 39: 
Δημιουργία 
Κατηγορίας 
Tutorial



Έτσι κάθε καινούργιο άρθρο που θα δημιουργείται  με κατηγορία tutorials αυτόματα θα 
εμφανίζεται στην Σελίδα Tutorials.

4.7. Δημιουργία σελίδας Επικοινωνίας.

Η σελίδα επικοινωνίας είναι αναγκαία καθώς οι επισκέπτες θα έχουν την δυνατότητα επικοινωνίας 
με του διαχειριστές της ιστοσελίδας. Αυτό είναι πολύ σημαντικό διότι θα μπορεί ο κάθε χρήστης να
θέτει τις ερωτήσεις, απορίες αλλά και ιδέες για την καλύτερη λειτουργία της ιστοσελίδας.

Για την δημιουργία της σελίδας γίνεται επιλογή από το πίνακα έλεγχου  της καρτέλας σελίδες και 
στην συνέχεια Νέα σελίδα. Στην συνέχεια ο Τίτλος της σελίδας θα είναι Contact.Η υλοποίηση της 
φόρμας επικοινωνίας θα γίνει με την χρήση του πρόσθετου Avia Layout Builder,στην καρτέλα 
Contect Elements γίνεται επιλογή Contact Form.[15]

Εικόνα 40: Post Slider Τutorials



Στην καρτέλα Contact Form [Εικόνα 41] γίνεται η υποβολή των στοιχείων που θα εμφανίζονται 
στην φόρμα.

Στο πεδίο Your email Adress γίνεται η καταγραφή του email όπου κάθε φόρα που θα επιθυμεί ένας 
χρήστης να επικοινωνήσει με την σελίδα θα λαμβάνει σε αυτό το email την φόρμα που 
συμπλήρωσε ο χρήστης . Το πεδίο form title αναφέρεται στον τίτλο που θα έχει η φόρμα.Το πεδίο 
Contact Form Elements περιλαμβάνει τα πεδία που θα συμπληρώνει ο χρήστης προκειμένου να 
στείλει την φόρμα επιτυχώς .Υπάρχουν προ υλοποιημένα τα πιο διαδεδομένα πεδία.

Η μορφή της  φόρμας που δημιουργήθηκε είναι [Εικόνα 42].

Εικόνα 41: Δημιουργία Φόρμας Εποικοινωνίας

Εικόνα 42: Φόρμα Εποικοινωνίας



4.8. Δημιουργία Σελίδας About

Η σελίδα about έχει ως κύριο σκοπό την γνωριμία του διαχειριστή – δημιουργού της σελίδας με 
τους χρήστες της σελίδας

Θα αναγράφονται πληροφορίες σχετικά για τον δημιουργό όπως επίσης και ο λόγος δημιουργίας 
αυτής της ιστοσελίδας .

H Σελίδα θα περιλαμβάνει μια φωτογραφία του δημιουργού. Καθώς και μια στήλη  με τις 
πληροφορίες στο κέντρο κάτω από την φωτογραφία.

Για την δημιουργία της σελίδας στον Πίνακα ελέγχου του Wordpress η επιλογή Νέα Σελίδα.

Ο Τίτλος της σελίδας θα είναι About .

Για την Υλοποίηση θα χρειαστεί η χρήση ενός Grid Row με 3 στήλες ,το κείμενο για να βρίσκεται 
στο κέντρο θα είναι καταχωρημένο στην μεσαία στήλη. Για την χρήση του Grid Row από το 
πρόσθετο στην καρτέλα Layout Elements γίνεται επιλογή Grid Row.Σείρα έχει η φωτογραφία του 
δημιουργού. Στην Καρτέλα του πρόσθετου γίνεται επιλογή Media Elements και image.Yλοιποίειται
ανέβασμα της φωτογραφίας και η σχετικές ρυθμίσεις για την φωτογραφία και τον τρόπο εμφάνισης
της. Έπειτα για την την δημιουργία της στήλης με τις πληροφορίες  θα γίνει πάλι χρήση ενός Grid 
Row και στην συνέχεια από την καρτέλα Layout Elements η δημιουργία τριών στηλών.  [Εικόνα 
43][15]

Στην μεσαία στήλη γίνεται η διαμόρφωση του κειμένου με το Special Heading για την δημιουργία 
τίτλου και Text Block για τις πληροφορίες από την καρτέλα Content Elements.Στην συνέχεια 
επιλογή δημιουργίας της σελίδας και είναι έτοιμη για χρήση.

Η τελική μορφή της σελίδας θα είναι .[Εικόνα 44]

Εικόνα 43: Σελίδα About



4.9. Δημιουργία Menu Πλοήγησης

Οι Σελίδες που θα χρησιμοποιηθούν είναι υλοποιημένες αλλά για την εμφάνιση τους στο Menu 
Πλοήγησης πρέπει να δημιουργηθεί το Menu σελίδων/κατηγοριών που θα εμφανίζεται.

Για την δημιουργία του menu από τον πίνακα ελέγχου του Wordpress γίνεται επιλογή στην 
Καρτέλα Εμφάνιση  Menu.[Εικόνα 45]

Στην σελίδα που εμφανίζεται γίνεται η επιλογή φτιάξτε ένα νέο Menu.Έπειτα στην ενότητα Σελίδες
αριστερά της σελίδας γίνεται επιλογή των σελίδων που θα εμφανίζονται στο Menu .

[Εικόνα 46]

Εικόνα 44: Σελίδα About

Εικόνα 45: 
Menu 
Πλοήγησης



Μετά την επιλογή των σελίδων στις  ρυθμίσεις μενού γίνεται επιλογή ως προεπιλεγμένο μενού και 
ως foot Menu ώστε στο Footer της σελίδας να εμφανίζονται οι σελίδες. Με την Ολοκλήρωση των 
ρυθμίσεων ,με την αποθήκευση του Μενού με την ανανέωση της αρχικής σελίδας θα εμφανιστεί το
καινούργιο Menu.[Εικόνα 47]

Η ιστοσελίδα είναι έτοιμη , επόμενο βήμα η δημιουργία των video για την διδασκαλία του 
λογισμικού Photoshop και έπειτα η ανάρτηση τους στο youtube και η δημιουργία άρθρων στην 
ιστοσελίδα.

5.Δημιουργία εκπαιδευτικών video – Tutorial για την διδασκαλία του 
λογισμικού Photoshop

Σε αυτήν την ενότητα θα υλοποιηθούν τα εκπαιδευτικά video για την διδασκαλία του λογισμικού 
Photoshop.Η δημιουργία των εκπαιδευτικών video θα πραγματοποιηθεί με την καταγραφή της 
οθόνης και την εγγραφή φωνητικής ηχογράφησης με αντίστοιχη επεξήγηση. 

Εικόνα 46: Επιλογή 
Σελίδων για το menu 
Πλοήγησης

Εικόνα 47: Δομή Menu



Τα video που θα υλοποιηθούν είναι:

 Εισαγωγικό video για την εξοικείωση με περιβάλλον  του λογισμικού Photoshop και μερικές
βασικές έννοιες.

 Διαγραφή παρασκηνίου και αντικατάσταση του.

5.1. Δημιουργία εκπαιδευτικού video για γνωριμία και την εξοικείωση με τον 
περιβάλλον του λογισμικού Photoshop.

Το πρώτο tutorial έχει ως σκοπό την γνωριμία και την εξοικείωση με το περιβάλλον του Photoshop.

Σύνδεσμος εκπαιδευτικού video : https://www.youtube.com/watch?v=VdCl_755rOU&l

Το περιβάλλον του Photoshop αποτελείται από την γραμμή εργαλείων που βρίσκεται αριστερά ,

το menu πλοήγησης στο πάνω μέρος ,δεξιά στο πάνω μέρος βρίσκεται ο πίνακας ρυθμίσεων και 
ακριβώς από κάτω ο πίνακας επιπέδων. [Εικόνα 48][18]

Εικόνα 48: Περιβάλλον Photoshop

https://www.youtube.com/watch?v=VdCl_755rOU&l


5.1.1. Γραμμή Πλοήγησης.

Η γραμμή πλοήγησης  περιλαμβάνει πολλά αναπτυσσόμενα menu για την επιλογή εντολών που 
επιθυμεί ο χρήστης να επιλέξει.

Επιλογή File : 

Η επιλογή File είναι η πρώτη επιλογή στην γραμμή πλοήγησης .

Στην επιλογή File πραγματοποιούνται ενέργειες σχετικά με το αρχείο που γίνεται επεξεργασία,όπως
δημιουργία ,άνοιγμα,κλείσιμο,αποθήκευση,εκτύπωση .[Εικόνα 49]

Επιλογή Edit :

 Η επιλογή αυτή σχετίζεται με την επεξεργασία αρχείων όπως μεταφορά – μετακίνηση 
,αντιγραφή ,αποκοπή,επικόλληση ,περιστροφή .[Εικόνα 50,51]

Εικόνα 49: Επιλογή File

Εικόνα 50: Επιλογή Edit 

Εικόνα 51: Επιλογή Edit



Επιλογή Image :

Η επιλογή Image αφορά ενέργειες σχετικά με την επεξεργασία για το αντικείμενο  που είναι 
επιλεγμένο στον πίνακα επιπέδων ,οι ενέργειες αυτές πραγματοποιούνται  στο επιλεγμένο επίπεδο 
και είναι μη αναστρέψιμες.[Εικόνα 52]

Επιλογή Layer :  

H επιλογή layer απευθύνεται σε ενέργειες που σχετίζονται με τα επίπεδα του αρχείου που 
επεξεργαζόμαστε . Μερικές από τις ενέργειες είναι  η δημιουργία καινούργιου Layer- επιπέδου 
.Δημιουργία επιπέδου ως background,υλοποίηση ρυθμίσεων σε καινούργιο επίπεδο όπου οι 
ρυθμίσεις αυτές θα αφορούν όλα τα προηγούμενα επίπεδα .Οι ρυθμίσεις αυτές βρίσκονται στον 
πίνακα ρυθμίσεων που αναλυθεί σε επόμενη ενότητα.[Εικόνα 53,54]

Εικόνα 52: Επιλογή Image 

Εικόνα 53: Επιλογή Layer

Εικόνα 54: Επιλογή Layer



Επιλογή Type:

Η επιλογή Type σχετίζεται με τα τυπογραφικά στοιχεία του αρχείου.[Εικόνα 55]

Επιλογή Select:

Η επιλογή Select αφορά την επιλογή στοιχειών από το αρχείο προς επεξεργασία.

Σε επόμενο tutorial θα γίνει ανάλυση της επιλογής αυτής.[Εικόνα 56]

Εικόνα 55: Επιλογή Type

Εικόνα 56: Επιλογή Selection



Επιλογή Filter:

Η επιλογή filter περιλαμβάνει όλα τα φίλτρα προς χρήση για την επεξεργασία αρχείων,υπάρχει η 
δυνατότητα επέκτασης και εγκατάστασης φίλτρων .Μερικά από τα πιο διαδεδομένα φίλτρα όπου 
είναι εγκατεστημένα στο Photoshop είναι Camera Raw filter,Liquify , Sharpen,blur και άλλα.
[Εικόνα 57]

Επιλογή 3D :

Με την επιλογή 3D υλοποιούνται ενέργειες σχετικά με την δημιουργία και την επεξεργασία 
αρχείων τρισδιάστατης μορφής.[Εικόνα 58,59]

Εικόνα 57: Επιλογή Filter

Εικόνα 58: Επιλογή 3D Εικόνα 59: Επιλογή 3D



Επιλογή View : 

Στην επιλογή View γίνονται ρυθμίσεις σχετικά με τον τρόπο εμφάνισης των αρχείων.[Εικόνα 60]

Επιλογή Window :

Στην επιλογή Window ενεργοποιούνται ή απενεργοποιούνται παράθυρα που επιθυμεί ο χρήστης να 
εμφανίζονται στο περιβάλλον  του λογισμικού.[Εικόνα 61,62]

Εικόνα 60: Επιλογή View

Εικόνα 61: Επιλογή Window

Εικόνα 62: Επιλογή Window



Επιλογή Help : 

Είναι η τελευταία επιλογή της γραμμής πλοήγησης. Αφορά την βοήθεια και την εξυπηρέτηση των 
χρηστών από την εταιρία Adobe.Οπως επίσης και της αναβαθμίσεις σχετικά με το λογισμικό αλλά 
και την αγορά / προσθήκη πρόσθετων για το λογισμικό Photoshop.[Εικόνα 63]

5.1.2. Άνοιγμα αρχείων 

Το άνοιγμα τον αρχείων μπορεί να υλοποιηθεί με δύο τρόπος.

Σύρε και άφησε  :

Η τεχνική αυτή είναι ευρέως γνωστή στους ηλεκτρονικούς υπολογιστές και στο διαδίκτυο.

Γίνεται επιλογή του αρχείου και με την τεχνική σύρε και άφησε γίνεται το άνοιγμα στο περιβάλλον 

Εικόνα 63: Επιλογή Help

Εικόνα 64



του Photoshop.[Εικόνα 64]

Άνοιγμα από το menu πλοήγησης:

Η τεχνική αυτή αποτελείται από μία σειρά βημάτων από το menu πλοήγησης και στην συνέχεια 
File και Open File στο αναπτυσσόμενο menu .Τέλος γίνεται επιλογή του αρχείου και Άνοιγμα.
[Εικόνα 65]

5.1.3. Γραμμή  Εργαλείων

Η γραμμή εργαλείων βρίσκεται αριστερά στο περιβάλλον του Photoshop.Τα εργαλεία όπου στο 
κάτω μέρος έχουν ένα βελάκι δηλώνουν ότι περιλαμβάνουν και άλλες επιλογές ,η προβολή αυτών 
των επιλογών γίνεται με δεξί κλικ στο εικονίδιο του εργαλείου.[19]

 Τα εργαλεία που περιλαμβάνει είναι: [Εικόνα 66]

Εικόνα 65



Move Tool (V) : 

Η χρησιμότητα του εργαλείου αυτού είναι για την μετακίνηση των αρχείων .

Η κύρια χρήση του είναι για την μετακίνηση ενός επιπέδου(Layer) πάνω στο επίπεδο που έχει 
τοποθετηθεί αυτό. Με το πάτημα του πλήκτρου shift γίνεται μετακίνηση σε κάθετη ή οριζόντια 
γραμμή.

Rectangular Marquee Tool (M):

Το εργαλείο αυτό χρησιμοποιείται  για την επιλογή στοιχειών στο αρχείο,η προεπιλογή είναι σε 
σχήμα ορθογωνίου . Η περιοχή που έχει επιλεχθεί επηρεάζεται από τα υπόλοιπα εργαλεία ή 
ενέργειες που βρίσκονται στο καθορισμένο σχήμα. Κρατώντας το πλήκτρο shift μπορούν να 
πραγματοποιηθούν πολλές επιλογές με το πλήκτρο Alt διαγράφονται περιοχές στην επιλογή που 
έχει ήδη υλοποιηθεί.[Εικόνα 67]

Εικόνα 66: Γραμμή Εργαλείων



 

Lasso Tool ( L):

Χρησιμοποιείται για σχεδιασμό της επιλογής σε ότι σχήμα επιθυμεί ο χρήστης. Στην επιλογή του 
Polygon Lasso με ο πάτημα του κουμπιού ctrl στην επόμενη επιλογή γίνεται κλείσιμο της επιλογής.

Quick Selection Tool(W):

 Το εργαλείο αυτό είναι το πιο διαδεδομένο εργαλείο επιλογής. Η επιλογή γίνεται με βάση 
χρώματος ανάλογα ποία περιοχή επιλέγει ο χρήστης. Το το Πλήκτρο Alt γίνεται διαγραφή μιας 
περιοχής που έχει επιλέξει ο χρήστης.

Crop Tool  (C) :

Το εργαλείο περικοπής λειτουργεί με  παρεμφερή τρόπο με το Rectangular Marquee tool .Η 
διαφορά ότι γίνεται περικοπή της επιλογής που έχει γίνει. Όλες οι πληροφορίες που βρίσκονται στο 
εξωτερικό της επιλογής αφαιρούνται.

Eyedropper Tool (I) :

Το εργαλείο αυτό ονομάζεται σταγονόμετρο ,λειτουργεί αλλάζοντας χρώμα προσκηνίου σε ότι 
χρώμα έχει επιλεχθεί. Με το πλήκτρο Alt αλλάζει το χρώμα του παρασκηνίου.

Healing Brush Tool (J):

Εικόνα 67



Το εργαλείο αυτό είναι ένα από τα ποιο χρήσιμα εργαλεία του Photoshop.Χρησιμοποείται για την 
αφαίρεση ελαττωμάτων,σημαδιών και ατέλειες . Λειτουργεί σαν πινέλο .Με την χρήση του 
πλήκτρου Alt γίνεται αντιγραφή του σημείου που έχει επιλεχθεί σε άλλο σημείο.

Brush Tool (B) : 

Το εργαλείο αυτό χρησιμοποιείται για την ζωγραφική πάνω στο αρχείο ,σε όλες τις χρωματικές 
επιλογές .

Clone Stamp Tool (S) :

Το εργαλείο αυτό είναι παρόμοιο με το Healing Brush Tool .Η χρήση του είναι ίδια. Είναι μία 
αντιγραφή στοιχείων από την πρώτη επιλογή στην δεύτερη.

History Brush Tool (H) :

Αυτό το εργαλείο λειτουργεί όπως το brush tool,εκτός από τις πληροφορίες που ζωγραφίζει είναι 
από την αρχική κατάσταση της εικόνας. Το εργαλείο πινέλου ιστορικού χρωματίζει με τις 
πληροφορίες από την Ιστορία κατάστασης.

Eraser Tool (E) :

Αυτό το εργαλείο λειτουργεί σαν μία γόμα διαγράφει ότι πληροφορίες υπάρχουν ,όπου γίνει 
επιλογή. Αν υπάρχουν παραπάνω από ένα επίπεδο θα διαγραφούν τα στοιχεία στο επίπεδο που είναι
επιλεγμένο από τον πίνακα επιπέδων.

Gradient Tool (G):

Με την χρήση αυτού του εργαλείου υλοποιείται μια διαβάθμιση χρωμάτων. Δημιουργεί μια 
ανάμιξη στα χρώματα του προσκηνίου και του παρασκηνίου .

Blur Tool (R):

To εργαλείο αυτό  κάνει τα αντικείμενα θολά.

Dodge Tool (O):



Το εργαλείο αυτό χρησιμοποιείται για να φωτίσει  οποιαδήποτε περιοχή μπορεί να χρησιμοποιηθεί 
για την λειτουργία αυτή.

Pen Tool (P):

Το εργαλείο αυτό βοηθάει στην δημιουργία μονοπατιών χρησιμοποιώντας την επιλογή.

Με την επιλογή ενός σημείου παρατεταμένα μέχρι το επόμενο η επιλογή θα είναι εύκαμπτη .

Horizontal Type Tool (T) :

Με το εργαλείο αυτό γίνεται η δημιουργία κειμένου. Υπάρχουν πολλές επιλογές για το εργαλείο 
αυτό.

Path Selection Tool (A): 

Η χρήση του εργαλείου αυτού σχετίζεται με μονοπάτια. Είναι παρεμφερές με το Pen Tool .

Rectangle Tool (U):

Με την χρήση αυτού του εργαλείου δημιουργείται μια καινούργια διαφάνεια με ένα σχήμα που 
είναι προεπιλεγμένο. Γεμίζει το σχήμα με χρώμα παρασκηνίου και περίγραμμα.

Hand Tool (T) :

Το εργαλείο αυτό βοηθάει στην μετακίνηση ολόκληρης της εικόνας μέσα από ένα παράθυρο. Το 
εργαλείο αυτό βρίσκει εφαρμογή ,όταν στο αρχείο που επεξεργάζεται βρίσκεται σε κατάσταση 
μεγέθυνσης βοηθάει στην περιήγηση γύρω από την εικόνα.

Zoom Tool (Z) :

Το εργαλείο αυτό βοηθάει στην μεγέθυνση της εικόνας. 

Foreground and background color tool :

Το εργαλείο αυτό χρησιμεύει για την επιλογή χρωμάτων στο προσκήνιο και στο παρασκήνιο 
αντίστοιχα.



5.1.4. Πίνακας ρυθμίσεων 

Ο Πίνακας ρυθμίσεων [Εικόνα 68] σχετίζεται με ενέργειες που γίνονται στο αρχείο που 
επεξεργαζόμαστε .
Η κάθε επιλογή δημιουργεί ένα καινούργιο επίπεδο με την αντίστοιχη ρύθμιση. Οι ίδιες ρυθμίσεις 
μπορούν να υλοποιηθούν και από Image > Adjustments .Η μεγάλη διαφορά είναι ότι οι ρυθμίσεις 
μέσω Image γίνονται απευθείας στην φωτογραφία που είναι επιλεγμένη στο επίπεδο ρυθμίσεων  
[Εικόνα 69]και είναι μη αναστρέψιμη. [20]

Brightness / Contrast 

Η ρύθμιση αυτή σχετίζεται με την Φωτεινότητα και την Αντίθεση της φωτογραφίας.[Εικόνα 70]

Εικόνα 68: Πίνακας ρυθμίσεων

Εικόνα 69: Πίνακας Επιπέδων



Levels

Σε αυτήν την επιλογή ρυθμίζονται τα επίπεδα φωτεινότητας της φωτογραφίας. Η φωτεινότητα 
χωρίζεται σε τρία επίπεδα τους σκοτεινούς τόνους ( Shadows) , μεσαίους τόνους (Mid tones) και 
τέλος φωτεινούς τόνους ( Hightlights).[Εικόνα 71]

Εικόνα 70: Brightness / Contrast 

Εικόνα 71: Levels



Curves

Η ρύθμιση Curves σχετίζεται όπως και η ρύθμιση levels με την φωτεινότητα της φωτογραφίας 
άλλα η διαφορά τους είναι ότι απεικονίζονται με την μορφή καμπύλης. Στην αρχή της καμπύλης 
βρίσκονται οι σκοτεινοί τόνοι,στην μέση οι μεσαίοι  και στο τέλος η φωτεινοί τόνοι.[Εικόνα 72]

Exposure

Η ρύθμιση αυτή σχετίζεται με την έκθεση της φωτογραφίας.[Εικόνα 73]

Vibrance

Είναι ένα έξυπνο εργαλείο το οποίο δημιουργεί ένταση στην φωτογραφία,από τα πιο απαλά 
χρώματα και αφήνει εκτός της έντασης τα ήδη υπάρχον κορεσμένα χρώματα.[Εικόνα 74]

Εικόνα 72: Curves

Εικόνα 73: Exposure



Hue/Saturation

Ο κορεσμός είναι μια επιλογή όπου γίνεται ανάμιξη των χρωμάτων μέχρι την μέγιστη ένταση 
αυτών.[Εικόνα 75]

Αυτά αυτές ήταν οι πιο βασικές ρυθμίσεις του πίνακα ρυθμίσεων. Οι υπόλοιπες θα αναλυθούν σε 
επόμενα tutorial .

5.1.5. Πίνακας Επιπέδων

Ο πίνακας επιπέδων αποτελείται από τα επίπεδα του αρχείου,τις ομάδες επιπέδων και το 
αποτέλεσμα των επιπέδων στην φωτογραφία. Με την χρήση του πίνακα επιπέδων υπάρχει η 
δυνατότητα της εμφάνισης και της απόκρυψης επιπέδων. Τέλος υπάρχει η δυνατότητα επιλογής του
τρόπου με τον οποίο ένα επίπεδο θα εμφανίζεται σε ένα άλλο.[Εικόνα 76][18]

Εικόνα 74: Vibrance

Εικόνα 75: Hue/Saturation



Έτσι ολοκληρώνεται το πρώτο εκπαιδευτικό Tutotiral για την γνωριμία με το περιβάλλον του 
λογισμικού Photoshop.

5.2. Δημιουργία εκπαιδευτικού video για την εκμάθηση  της αφαίρεση , 
αντικατάσταση παρασκηνίου  και διαγραφή αντικειμένων από μια 
φωτογραφία .

Σκοπός δημιουργίας αυτού του tutorial είναι η κατανόηση των εργαλείων select ,η χρησιμότητα 
τους για την αφαίρεση και την αντικατάσταση παρασκηνίου μιας φωτογραφίας. Στην συνέχεια η 
διαγραφή αντικειμένων από μια φωτογραφία .

Σύνδεσμος εκπαιδευτικού video :http://youtu.be/QLYSF-KSpW4

5.2.1. Αφαίρεση και αντικατάσταση παρασκηνίου μιας φωτογραφίας.

Για την υλοποίηση αυτού του tutorial θα γίνει χρήση μιας φωτογραφίας που έχει γίνει επιλογή.

Ξεκινώντας μετά το άνοιγμα του λογισμικού,σειρά έχει η φωτογραφία. Όπως αναλύθηκε πιο πάνω.
[Εικόνα 77]

Εικόνα 76: Πίνακας Επιπέδων



  

Για την επιλογή του αντικείμενου που θα παραμείνει στην φωτογραφία ή το παρασκήνιο που θα 
διαγραφή θα γίνει χρήση των Select Tools.Για την φωτογραφία καταλληλότερο εργαλείο είναι το 
quick selection tool .[Εικόνα 78]

Aφού έγινε επιλογή του εργαλείου. Κάτω από το menu πλοήγησης υπάρχουν όλες οι ρυθμίσεις για 
το εργαλείο.[Εικόνα 79]

Εικόνα 77: Άνοιγμα αρχείου

Εικόνα 78: Selection Tool

Εικόνα 79: Ρυθμίσεις Selection Tool



Αφού έχει γίνει επιλογή στο εικονίδιο όπου αναγράφεται το πρόσημο + και μίας βούρτσας στο 
μέγεθος που είναι ιδανικό για την φωτογραφία .Το μέγεθος την βούρτσας μπορεί να αλλάξει επίσης 
και από το πληκτρολόγιο με το πάτημα του κουμπιού αγκύλη <<[>> για μεγέθυνση,είτε με <<]>> 
μια σμίκρυνση. Αφού γίνει η επιλογή του παρασκηνίου της φωτογραφίας. Απομένει η αντιστροφή 
της επιλογής διότι έχει γίνει επιλογή του παρασκηνίου .Αυτό υλοποιείται από Select > Inverse .
[Εικόνα 80]

Στις δύο φωτογραφίες που ακολουθούν φαίνεται η διαφορά στην επιλογή.
Στην πρώτη φωτογραφία [Εικόνα 1] έχει επιλεχθεί το αντικείμενο,ενώ στην δεύτερη [Εικόνα 82]το
 παρασκήνιο.

Στην συνέχεια γίνεται επιλογή Refine Edge .[Εικόνα  83]

H Επιλογή Refine Edge σχετίζεται με τον τρόπο τον οποίο μπορούν να βελτιστοποιηθούν οι ακμές 
και οι άκρες των αντικειμένων στα Selections Tools.

Εικόνα 81 Εικόνα 82

Εικόνα 80: Inverse



Η πρώτη επιλογή του Refine edge είναι το

 View Mode:

Η επιλογή αυτή ρυθμίζει τον τρόπο τον οποίον προβάλλεται η επιλογή που έχει ήδη υλοποιηθεί.

Μερικές επιλογές είναι σε λευκό φόντο,σε μαύρο φόντο.

Η επιλογή αυτή χρησιμοποιείται για να εμφανίζονται με μεγαλύτερη ακρίβεια η λεπτομέρειες  που 
χρειάζονται  επεξεργασία και διαμόρφωση.

Edge Detection : 

Με την χρήση της ρυθμιστικής μπάρας Radius ,γίνεται εμφάνιση στοιχείων που αρχικά δεν 
συμπεριλαμβάνονται στην επιλογή. Η επιλογή Smart Radius τείνει να βοηθήσει με την επιλογή με 
διαφορετικούς τύπους ακμών. Κύρια χρήση του Smart Radius είναι για την επιλογή μαλλιών που 
προεξέχουν και είναι δύσκολα στην επιλογή.

Adjust Edge Options:

Η επιλογή Smooth χρησιμοποιείται για εξομαλύνση των ακανόνιστων άκρων , αλλά συνήθως 
προκαλεί προβλήματα κατά την επιλογή των μαλλιών.

Η επιλογή  Feather κάνει τα πράγματα να φαίνονται μαλακά ώστε να μην προεξέχουν στοιχεία 
όπως μαλλιά ,τρίχες.

Η επιλογή Contrast  ενισχύει της αντίθεση της φωτογραφίας στις άκρες.

Εικόνα 83: Refine Edge



Τέλος η επιλογή Shift Edge έχει την δυνατότητα της επέκτασης ή της μείωσης των ακμών .

Στην φωτογραφία που έχει επιλεχθεί οι ρυθμίσεις που προτείνονται είναι :[Εικόνα 84] .

Output

Η επιλογή output περιλαμβάνει το Decontaminating The Colors και Output  To.

Decontaminating The Colors : 

Με την ρύθμιση αυτή αφαιρούνται τα περιττά pixel και αφαιρεί τα χρώματα που έχουν  απομείνει 
σε στοιχεία της επιλογής όπως μαλλιά και τρίχες από το προηγούμενο παρασκήνιο της 
φωτογραφίας.

Output to:

Στην ρύθμιση αυτή επιλέγεται ο τρόπος με τον οποίον θα γίνει εξαγωγή της επιλογής που έχει 
πραγματοποιηθεί. Η καλύτερη επιλογή είναι η δημιουργία ενός καινούργιου επιπέδου με μια μάσκα
επιπέδου.

Εικόνα 84: Προτεινόμενες ρυθμίσεις 



Οι προτεινόμενες ρυθμίσεις για την φωτογραφία : [Εικόνα 85] .

Με την ολοκλήρωση των ρυθμίσεων έχει δημιουργηθεί ένα καινούργιο επίπεδο με μια μάσκα.

[Εικόνα 86]

Έτσι ολοκληρώνεται η διαγραφή παρασκηνίου από μια φωτογραφία.

Αντικατάσταση παρασκηνίου σε μία φωτογραφία.

Πρώτο βήμα είναι το άνοιγμα του αρχείου που θα τεθεί ως παρασκήνιο.

Για το άνοιγμα του αρχείου στο αρχείο που ήδη είναι ανοιχτό γίνεται επιλογή File > Place επιλογή 
της φωτογραφίας και Place.

Εικόνα 85
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Το καινούργιο αρχείο βρίσκεται πρώτο στον πίνακα επιπέδων. [Εικόνα 87]Θα γίνει διαγραφή του 
παλιού background είτε με το πλήκτρο Delete είτε από τον Menu πλοήγησης Layer > Delete layer .

Επόμενο βήμα η μετακίνηση του καινούργιου background στο τελευταίο επίπεδο του αρχείου.

Ο καινούργιος πίνακας επιπέδων διαμορφώνεται έτσι:

Με την μετακίνηση αυτή εμφανίζεται το αντικείμενο πάνω στο παρασκήνιο ,όμως επειδή το 
μέγεθος του αντικείμενου είναι μεγαλύτερο από το παρασκήνιο είναι μεγαλύτερο και ξεπερνάει τις 
διαστάσεις του .Με την επιλογή του αντικειμένου από το πίνακα επιπέδων και Edit >  Free 
Transform ( Ctrl + T από το πληκτρολόγιο) και πατημένο το Shift ,ώστε να μην αλλοιωθούν  οι 
αναλογία των διαστάσεων γίνεται σμίκρυνση του αντικείμενου ώστε να ταιριάζει με το 
παρασκήνιο.[Εικόνα 88]

Εικόνα 88
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Το αρχείο θα έχει την μορφή : [Εικόνα 89].

Τέλος σειρά έχει η περικοπή της φωτογραφίας ώστε να μην υπάρχουν περιθώρια.

Αυτό υλοποιείται με την χρήση Crop Tool από την γραμμή εργαλείων.

5.2.2. Διαγραφή αντικειμένων από μια φωτογραφία.

Για την διαγραφή αντικείμενων από μια φωτογραφία θα πρέπει να γίνει χρήση μιας φωτογραφίας.
Αφού πραγματοποιηθεί άνοιγμα της φωτογραφίας με έναν από τους τρόπους που αναλύθηκαν σε 
προηγούμενο tutorial.[Εικόνα 90]

Εικόνα 89



Από την πιο πάνω φωτογραφία αναλυθεί το πως μπορεί να διαγραφή το αρκουδάκι από την 
φωτογραφία χωρίς να αλλοιωθεί η εικόνα.

Fill – Content Aware 

Για την υλοποίηση του πρώτου τρόπου απαιτείται επιλογή του αντικειμένου για διαγραφή με την 
χρήση Selection tools.[Εικόνα 91]

Έπειτα θα χρησιμοποιηθεί η εντολή Fill – γέμισμα και πιο συγκεκριμένα η επιλογή Content 
Aware.Το Photoshop με την επιλογή αυτή προσπαθεί να καλύψει το επιλεγμένο σημείο με βάση τις 
γύρω περιοχές. Γίνεται επιλογή της εντολής Edit > Fill (Shift + F5 από πληκτρολόγιο).[Εικόνα 92]

Εικόνα 90
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Στο Menu που εμφανίζεται γίνεται επιλογή Content-aware.[Εικόνα 93]

Με την ολοκλήρωση της εντολής το αποτέλεσμα είναι αρκετά ικανοποιητικό αλλά υπάρχουν 
λεπτομέρειες που απαιτούν  διόρθωση.

Εικόνα 92
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Για την διόρθωση αυτών τον λεπτομερειών γίνεται χρήση Healing Tools και πιο συγκεκριμένα Spot
Healing Brush Tool.[Εικόνα 95]

Με ένα κατάλληλο μέγεθος βούρτσας για τις λεπτομέρειες αφαιρούνται όλες οι ατέλειες είτε με ένα
ένα κλικ είτε με συνεχόμενη κύλιση της βούρτσας. Έτσι αφαιρούνται με ακρίβεια η ατέλειες της 
φωτογραφίας.[Εικόνα 96]

Εικόνα 94
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Εικόνα 97: Πριν Εικόνα 98: Μετά

5.3. Δημιουργία εκπαιδευτικού video για δημιουργία αντανάκλασης σε μια 
φωτογραφία.

Σκοπός δημιουργίας αυτού του εκπαιδευτικού video είναι η δημιουργία ρεαλιστικής αντανάκλασης 
ενός αντικειμένου σε μια φωτογραφία.

Σύνδεσμος εκπαιδευτικού video : http://youtu.be/ZzMPfWcZneQ

5.3.1. Επιλογή περιοχής για την δημιουργία της αντανάκλασης

Αφού πραγματοποιηθεί το άνοιγμα της φωτογραφίας με την χρήση ενός Selection tool – Εργαλείου
επιλογής και πιο συγκεκριμένα το Rectangular Marquee Tool γίνεται επιλογή της περιοχής όπου θα 
δημιουργηθεί η αντανάκλαση.[Εικόνα 99]



5.3.2. Δημιουργία αντιγράφου σε νέο επίπεδο της επιλεγμένης περιοχής

Στην συνέχεια από το menu  Layer > New > Layer via Copy ή από το πληκτρολόγιο Ctrl + J 
δημιουργείται ένα καινούργιο επίπεδο με την επιλεγμένη περιοχή.[Εικόνα 10]

5.3.3. Περιστροφή και τοποθέτηση του νέου επιπέδου.

Μετά την δημιουργία του νέου επιπέδου από το menu edit > Transform > Flip Vertical γίνεται 
περιστροφή του επιπέδου όπως δηλαδή είναι και η αντανάκλαση. Στην συνέχεια από το menu Edit 
> Free Transform ή από πληκτρολόγιο Ctrl + T γίνεται τοποθέτηση του επιπέδου στο σημείο όπου 
θα δημιουργηθεί η αντανάκλαση.[Εικόνα 101]
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Η αντανάκλαση δημιουργήθηκε αλλά όμως δεν είναι ρεαλιστική.

5.3.4. Ολοκλήρωση Αντανάκλασης

Για την ολοκλήρωση της αντανάκλασης ώστε να είναι ρεαλιστική απαιτείται ελάττωση του opacity 
και Fill  περίπου στο 30% όπου βρίσκεται στο Layers Panel και του Blending Mode από Normal σε
screen.

H αντανάκλαση μοιάζει πιο ρεαλιστική [[Εικόνα 102]αλλά είναι αναγκαία η διαγραφή των 
περιοχών που βρίσκονται στην στεριά και όχι στο νερό διότι αντανάκλαση μπορεί να υπάρχει μόνο 

Εικόνα 101
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στο νερό .Αυτό επιτυγχάνεται με την χρήση ενός Layer Mask και την αντιστροφή του χρώματος 
παρασκηνίου σε μαύρο και στην συνέχεια με την χρήση ενός Brush tool γίνεται διαγραφή των 
περιοχών που δεν πρέπει να φαίνονται σαν αντανάκλαση.

Έτσι η δημιουργήθηκε μια ρεαλιστική αντανάκλαση στην φωτογραφία.[Εικόνα 103]

5.4. Τρόπος δημιουργίας εκπαιδευτικών video.

Για την δημιουργία των εκπαιδευτικών video για την διδασκαλία του λογισμικού photoshop έγινε 
χρήση ενός προγράμματος καταγραφής οθόνης και φωνής του χρήστη και ένα πρόγραμμα 
επεξεργασίας των video.

5.4.1. Καταγραφή οθόνης

Για την καταγραφή της οθόνης και της ομιλίας έγινε η χρήση του προγράμματος Snagit  [Εικόνα 
104]της εταιρίας Techsmith .H επιλογή του προγράμματος έγινε με στόχο την ποιοτική καταγραφή 
της οθόνης σε υψηλή ανάλυση Full HD .[21]

http://www.techsmith.com/snagit.html

Η πρώτη ενέργεια στο πρόγραμμα είναι η επιλογή του χώρου όπου θα γίνεται η καταγραφή του 
video.[Εικόνα 105]

Εικόνα 103
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http://www.techsmith.com/snagit.html


Η περιοχή που περιλαμβάνεται εντός των κίτρινων γραμμών θα γίνεται καταγραφή .

Στην συνέχεια γίνεται επιλογή για την καταγραφή video στην επιλογή με την κάμερα.[Εικόνα 106]

Η επιλογή της φωτογραφίας δημιουργεί ένα στιγμιότυπο της περιοχής που έχει ήδη επιλεχθεί .[21]

Και στην συνέχεια με την ολοκλήρωση των video γίνεται αποθήκευση.

5.4.2. Επεξεργασία video 

Για την επεξεργασία των video γίνεται χρήση ενός ακόμη προγράμματος της εταιρίας Adobe , το 
Adobe Premiere .[Εικόνα 107]

Η χρήση αυτού του προγράμματος είναι αναγκαία ώστε να ενοποιηθούν όλα τα αποσπάσματα για 
την δημιουργία του κάθε tutorial.[22]

Εικόνα 105
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Η φωτογραφία [Εικόνα 108]απεικονίζει την επεξεργασία ενοποίησης των video για την δημιουργία 
tutorial.

Με την ολοκλήρωση της επεξεργασίας σειρά έχει η εξαγωγή του video .Έτσι ολοκληρώνεται η 
διαδικασία δημιουργίας των video.[Εικόνα 109][22]

Εικόνα 107: Adobe Premiere Logo
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5.4.3. Ανάρτηση των video . 

Τα video που δημιουργήθηκαν θα αναρτηθούν στον ισότοπο youtube.com.

Η Χρήση της ιστοσελίδας αυτής έγινε με δυνατότητα που παρέχει για απεριόριστο bandwitdh που 
παρέχει αλλά και την δυνατότητα δημιουργία εσόδων μέσω των προβολών και διαφημίσεων.[23]

5.4.4. Κοινοποίηση στην ιστοσελίδα.

H κοινοποίηση των video θα πραγματοποιηθεί με την δημιουργία άρθρων(posts).

Για την δημιουργία ενός άρθρου γίνεται επιλογή Posts και στην συνέχεια προσθήκη ενός νέου 
άρθρου. Στο πεδίο Προσθήκη Τίτλου γίνεται η καταχώρηση του τίτλου για το tutorial που θα 
δημιουργηθεί. Στην Συνέχεια γίνεται επιλογή Προσθήκη Πολυμέσων ,γίνεται επιλογή Εισαγωγή 
από Url και τοποθετείται ο σύνδεσμος του video που αναρτήθηκε και ο τίτλος .[24]

Έπειτα γίνεται επιλογή της επιλεγμένης εικόνας όπου θα εμφανίζεται στην σελίδα Tutorials όπου 
θα περιλαμβάνει όλα τα άρθρα σχετικά με τα tutorials.Βρίσκετε δεξιά στο κάτω μέρος της σελίδας.

 Τέλος γίνεται επιλογή της κατηγορίας όπου θα ανήκει το παρών άρθρο ,στην περίπτωση αυτή 
επιλέγεται η κατηγορία tutorial.Σε περίπτωση που δεν γίνει επιλογή της κατηγορίας δεν θα 
εμφανίζεται το άρθρο στην σελίδα tutorial.Όταν όλα τα πεδία έχουν συμπληρωθεί η το άρθρο είναι 
έτοιμο για δημοσίευση.
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